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Pictures/Attachments and eSignatures  

Click American Data - ECS, follow the path Help > Videos, and check out the Electronic 
Signatures video for additional information.  

Digital pictures and scanned images may be stored in ECS. Client pictures are generally used for 
identification purposes in ECS. They may be printed on reports such as the face sheet or medication 
administration records and they may be displayed on the electronic sign and Write screens. Other 
pictures/images may be stored in ECS as well. Pictures of wounds, copies of insurance cards, or copies of 
lab reports may be placed on a client's record.  

Because pictures take a lot of room to store and may slow down the system, American Data 
recommends purchasing a server for the pictures if your facility plans to store a large amount of images 
in the system. There are two ways to store pictures in ECS: as a picture file (.jpg, .gif, .bmp) or as an 
attachment (.tif, .pdf, .txt, .exe). Each has its advantages.  

 
 

Pictures Attachments 

Viewing Pictures may be 
viewed in ECS by 
using the View 
icon. 

Attachments do not appear on the view entries screen in 
ECS. A link stating "Picture" with a scroll attached is 
displayed in its place on the view screen. To view the 
attachment, double-click on the link. The application 
needed to view the attachment opens and the file appears. 
For example, if the attachment is a .pdf file, then Acrobat 
Reader opens and displays the file. 

Printing Pictures may be 
printed on ECS 
reports or the 
View screen. 

Attachments cannot be printed on ECS reports. 
Attachments are printed from the application they are 
viewed in. 

Write 
Screen 

Pictures may be 
viewed on the 
Write screen. 

Attachments cannot be viewed on the Write screen. 

Sign 
Screen 

Pictures may be 
viewed on the 
Electronic Sign 
screen. 

Attachments cannot be viewed on the Electronic Sign 
screen. 

How it 
affects 
ECS 

View screens may 
load more slowly 
when displaying 
pictures. 

View screen loading time is unaffected by the presence of 
attachments.  

Pictures  
Pictures may be stored in .jpg, .gif, or .bmp format. The file name should not include slashes or invalid 
characters (examples of invalid characters include @, #, ( ), *). Pictures can be stored on a Network or 
Local drive. Picture files are typically too large and need to be resized. The height and width should not 
be greater than 400 (i.e., 300 x 400 is acceptable). The picture file size should be less than 500K.  
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ECS has a picture re-sizer built into the system. When the user brings the image into ECS (either via a 
Write screen or via setup screen,) the image is opened in the re-sizer. The user may manipulate the size 
of the image. ECS does automatically shrink large photos to a more appropriate size so that the user 
may simply click OK on the re-sizer screen.  

Document Pictures  
Pictures may be documented in any area of ECS (from face sheets to nursing notes to physician orders). 
All systems have the ability to document a client picture for identification. This is the example that is 
used.  

1. Click the Write icon.  

2. Select the desired client and click OK.  

3. Click Topic.  

4. Select Face Sheet.  

5. Select Client Pictures and click OK.  

6. Click the question word.  Question words are headings. On a Write screen, they are 

typically gray and in capital letters. Question words precede canned words/phrases 

and free type. The question words help define what the information that follows is 

about. For example, if the canned phrase "needs assist" is documented in the record 

without the question word "EATING," then no one would know what the client needed 

assistance with. Many reports and links in the system depend on the proper use of 

question words. "Picture".  

7. Click the word "Browse for Picture". A browser window opens. Locate the picture file 

for the selected client.  

8. Click on the file to highlight it and click Open.  

9. The picture opens in the ECS re-sizer. You may adjust the image size or click to save 

the image size that ECS has selected. The file name is displayed in the text box.  

10. Click Save and Exit.  

View Pictures  
1. Click the View icon.  

2. Select the desired client(s) and click OK.  

3. Click Topic.  

4. Select the desired section (i.e., the section where the picture is documented).  

5. Select the desired topic (i.e., the topic where the picture is documented) and click OK.  

6. Click Go.  

Print Pictures  
Pictures may be printed two different ways in ECS. To print a picture from a view screen follow these 
steps:  

1. Click the View icon.  

2. Select the desired client(s) and click OK.  

3. Click Topic.  

4. Select the desired section (i.e., the section where the picture is documented).  
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5. Select the desired topic (i.e., the topic where the picture is documented) and click OK.  

6. Click Go.  

7. Click the Print icon.  

Pictures may be printed on reports. In order for a picture to appear on the report the picture must be 
linked to the setup of the report. For more information on setting up reports please refer to the Report 

Maker section of the manual. To print reports:  

1. Click the Reports icon.  

2. Select the desired client(s) and click OK.  

3. Select the desired report (e.g,. Face Sheet) and click OK.  

Use Pictures for Charting  
Pictures may be added to the word grid in place of words. Instead of clicking on a word like "1 Assist," 
you can click on a picture of one assistant. When pictures are used in the documenting grid for charting 
purposes, the picture does not print in the chart. Instead, a word or words describing the picture are 
actually documented. Picture charting is used within our CNA Charting module in ECS. 

 

Attachments  
Attachments may be stored in .tif, .pdf, .txt, or .exe format. The file name should not include spaces or 
invalid characters (examples of invalid characters include @, #, ( ), *). Attachments can be stored on a 
network or local drive. Attachments do not require resizing, but the file size should be less than 500K. 
Keep in mind that computers must have the ability to run the applications needed to open these 
attachments.  

Create Report Attachments 
In order to save a signed report in a client’s record, there has to be an attachment setup. This can be 
done by creating words related to the type of report within a topic. For example, the Scanned 
Documents folder within Face Sheet could have words setup to be the designated area for scanned 
items. Signed reports can be attached anywhere within the system as long as they can easily be found 
should they need to be reviewed.  

 

file://///AmData-FS-04/Documents/Client%20Services/ECS%20Manual/ECS%20Manual/Report_Maker.htm
file://///AmData-FS-04/Documents/Client%20Services/ECS%20Manual/ECS%20Manual/Report_Maker.htm
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To be able to attach reports to a patient’s chart, the appropriate user group 
must be given the following right: View > Preview > Attach. 

To create an attachment for a report: 

1. Click the American Data – ECS button and follow the path Setup 

> Reports > Report Maker. 

2. Click the Open icon , highlight the report to be edited, and click OK. 

3. Once the report has loaded, click the Options icon . 

4. Click the picklist next to the Attach field and pull in the word that you want the report to 

be saved under in the client’s record. A report can only have one word that it will 

writeback to.  To delete the path that has been saved within a report, click the trashcan 

icon . 

 

 
5. Click OK to close the Options window.  

6. Click the Save icon to save any changes to the report. 

Manual Attachments 
• If a report is not set up to be attached to the chart, the user has the opportunity 

to manually attach the signed document somewhere within the client’s record.  

• If a report is set up to be attached to the chart, the user still has the opportunity 

to attach the report to a different resident or to a different location in the chart. 
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To be able to attach reports manually to a patient's chart, the appropriate user 
group must be given the following right: View > Preview > Manual Attach. 

 
To manually attach a report: 

1. Follow the steps of setting up Signature fields within the report.  

2. Preview the report in order to sign it as described in the above steps.  

3. Once in the Preview screen, if there is no Attach set up on the report, this button will be 

greyed out. Select the Manual checkbox . 

4. The Attach button will now be enabled. 

Click Attach. The user will be prompted 

with the opportunity to attach the 

report to different client's chart if they 

want.  

5. If saving the report to the original 

client(s) selected, click No. The user will 

now be presented with the chart to select the path they want the report to attach to.  

6. Once the path has been selected, click OK.  

7. After the document has attached to the path that was selected, the user will be 

presented with Audit Results verifying where it was attached.  

8. Click Close to exit the Audit Results.  

9. Click Exit to close the Preview screen. 

Document Attachments  
Attachments may be documented in any area of ECS. Attachments are documented following the same 
steps as documenting pictures in a chart. The only difference is the file that is selected is of .tif, .pdf, .txt, 
or .exe format instead of the picture formats of .jpg, .gif, .bmp.  

1. Click the Write icon.  

2. Select the desired client and click OK.  

3. Click Topic.  

4. Select the desired section.  

5. Select the desired topic.  

6. Click the Question Word for the attachment/electronic file.  

7. Click the word Get File/Attachment. A browser window opens. Locate the desired file 

for the selected client.  

8. Click the file to highlight it and click Open. The file name is displayed in the text box.  

9. Click Save and Exit.  

View Attachments  
1. Click the View icon.  

2. Select the desired client(s) and click OK.  

3. Click Topic.  

4. Select the desired section (the section where the attachment is documented).  
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5. Select the desired topic (the topic where the attachment is documented) and click OK.  

6. Click Go. The word "Picture" appears with a scroll icon in the View screen.  

7. Close out of the attachment and view screen when finished. 

Attachments may be added to report as well if desired with the picture or print files fields. 

Print Attachments  
There are two ways attachments may be printed in ECS: (1) from a View screen, or (2) from ECS reports.  

Print from a View screen  
All attachment types may be printed from a view screen barring that the computer has that program. 
For example, in order to print a Microsoft Word document from ECS, the computer must have access to 
Microsoft Word.  

1. Click the View icon.  

2. Select the desired client(s) and click OK.  

3. Click Topic and select the topic where the attachment was documented and click OK.  

4. Click Go.  

5. A scroll appears on the view screen. Click on the scroll and the document appears.  

6. Click Print on the document.  

• If using Adobe to preview reports, the main Adobe toolbar is hidden by default. 

The printer icon from ECS will appear with a paperclip which denotes "Print with 

Attachments". Click the chevron (double arrows) symbol to display the Adobe 

toolbar. 

Print from ECS reports  
Only one attachment may be pulled to an ECS report - PDF files. All other attachments must be printed 
from a view screen. In order to print PDF files from ECS reports, a report must be created with the link 
for the attachment. For additional information, refer to the Report Maker section of the manual.  

1. Click the Reports icon.  

2. Select the desired client(s).  

3. Select the report specifically made to print these attachments and click OK.  

4. Click OK.  

Electronic Signatures 
Incorporating electronic signatures on many of the reports we print from within ECS has many benefits 
including: 

• Time reduced by not having to print, sign, scan, fax, or mail as many hard copies.  

• Money saved by reducing the amount of paper and ink used from printing.  

• Developing an archive to store the signed reports within the client’s electronic medical 

record.  

• The ability to send signed documents digitally to involved parties.  

file://///AmData-FS-04/Documents/Client%20Services/ECS%20Manual/ECS%20Manual/Report_Maker.htm
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eSign Reports  
After signature fields have been created, and writebacks have been set up, the reports are now ready to 
be signed within ECS and saved to the client’s record.  

To sign a report with a signature field 
1. To preview a report, click the Reports icon. 

2. Highlight the report to be signed, select the client(s), select any dates (if applicable), 

select the Preview checkbox, and click OK.  

3. Once in the Preview screen, click the Signature button. A box detailing the title of the 

signature will appear. 

• This button will be grayed out if there are no signature fields detected on the 

report setup.  

4. Place your mouse inside the box, hold down the left button, and sign your name.  

• To erase your signature, click the Clear icon and then re-sign in the box.  

 

5. To make the signature box larger, click the magnifying glass icon. 

6. Click OK to save the signature to the report.  

7. If the report is not being written back into the client’s record, the user may now print, 

save, or email the signed report from the Preview screen.  

To attach a report with a signature field 
1. Complete the steps above to sign the report as normal.  

2. Once in the Preview screen, an Attach button will appear if the report is set up to be 

attached to the chart. This button will be greyed out if there is no attachment on the 

report setup. Click Attach to save the signed report within the client’s record. After the 

document has been attached to the path that was set up, the user will be presented 

with Audit Results verifying where it was attached.  

 

3. Click Close to exit the Audit Results.  

4. Click Exit to close the Preview screen.  

 

file://///AmData-FS-04/Documents/Client%20Services/ECS%20Manual/ECS%20Manual/Report_Maker.htm%23Signature_tab
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Sign a Report with Multiple Signature Fields 
1. Follow the steps of setting up signature fields within the report.  

2. Preview the report in order to sign it as described in the steps above.  

3. Click Signature. A panel will appear on the left side of the 

screen detailing the report name, the client selected, and 

the tile of the signatures that have been set up.  

4. Double-click on the signature to be signed and the 

signature box will appear. Place your mouse inside the 

box, hold down the left button, and sign your name. Click OK once the signature has 

been obtained.  

5. Complete this for all signature fields present on the report.  

6. Attach or print the report if desired, and then click Exit to close the Preview screen.  

Sign Multiple Reports with Multiple Signature Fields 
Multiple reports with Signature fields set up can now be previewed at the same time. This allows the 
user to sign multiple reports at once, such as an admission packet of information.  

1. Follow the steps of setting up signature fields within the report.  

2. Preview the report in order to sign it as described in the above steps.  

3. Click Signature. A panel will appear on the left side of the screen detailing the report 

names, the client selected, and the title of the signatures that have been set up.  

4. Double-click on the signature to be signed and the signature box will appear. Click OK 

once the signature has been obtained.  

5. If signature fields have the same 

identifier attached to them, such as the 

DON, the user will be asked if they 

want to apply the signature to all 

pages. Select Yes if the signature 

applies to all pages, or select No to 

only sign one signature field.  

6. Complete this for all signature fields present on the report.  

7. Attach or print the report if desired, and then click Exit to close the Preview screen..  

Sign a Report for Multiple Clients 
Multiple clients for one report can be previewed at the same time in order to obtain one signature to 
apply to everyone.  

1. Follow the steps of setting up signature fields within the report.  

2. Preview the report with multiple clients selected in order to sign.  

3. Click Signature. A panel will appear on the left side of the screen detailing the report 

name, the clients selected, and the title of the signature that has been set up.  

4. The signature box will automatically load if there is only one set up on the report.  

5. Click OK once the signature has been obtained.  
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6. The user will be asked if they want to apply the signature to all pages because they 

have the same identifier. Select Yes to apply the one signature to all client pages.  

7. Attach or print the report if desired, and then click Exit to close the Preview screen. 

Sign Multiple Reports for Multiple Clients 
Multiple clients for multiple reports can be previewed at the same time in order to obtain one signature 
to apply to everyone.  

1. Follow the steps of setting up signature fields within the reports.  

2. Preview the reports with multiple clients selected in order to sign. 

3. Click Signature. A panel will appear on the left side of the screen detailing the report 

names, the clients selected, and the title of the signature that has been set up.  

4. The signature box will automatically load if the identifiers are the same for all reports.  

5. Click OK once the signature has been obtained.  

6. The user will be asked if they want to apply the signature to all pages because they 

have the same identifier. Select Yes to apply the one signature to all client pages for all 

selected reports.  

7. Attach or print the report if desired, and then click Exit to close the Preview screen. 

Sign Multiple Reports with Multiple Signature Fields for Multiple Clients 
Multiple clients for multiple reports can be previewed at the same time in order to obtain multiple 
signatures to apply to everyone.  

1. Follow the steps of setting up signature fields within the reports. 

2. Preview the reports with multiple clients selected in order to sign. 

3. Click Signature. A panel will appear on the left side of the screen detailing the report 

names, the clients selected, and the title of the signature that has been set up.  

4. Double click-on the signature to be signed and the signature box will appear. Click OK 

once the signature has been obtained.  

5. The user will be asked if they want to apply the signature to all pages because they 

have the same identifier. Select Yes to apply the one signature to all client pages for all 

selected reports.  

6. Complete this for all signature fields present on all reports.  

7. Attach or print the report if desired, and then click Exit to close the Preview screen. 

View Signed Documents 
Once signatures have been obtained, and the report is attached to the client’s record, these can be 
viewed at any time.  

1. Click the View icon. 

2. Highlight the name(s) of the client(s) and click OK. 

3. Select Topic, and find the path where the report is set up to attach within the client’s 

record.  

4. Highlight the word(s) and click OK.  
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5. Click Control and use the Control window to define date ranges or other filters for the 

View screen.  

6. Click Go.  If a signed report 

has been attached, it will 

appear in the View screen 

similar to this: 

7. Click on the folder to preview the report.  

Attachment Setup 
A filing system for attachments should be established. Attachments should be organized by the type of 
attachments which are scanned and downloaded for easy retrieval in a view screen or report. For 
example, if the facility is planning on scanning lab information, they may want to setup a lab scan folder 
in nurses notes, so that all scanned documents from the lab can be found in one place.  

1. Go to the Setup icon. 

2. Click the tab the folder will be created in. 

3. Right-click in a white space and choose New. 

4. Select Yes to create a new topic. 

5. Enter the topic name in the short name field. 

6. Click OK to save the new topic. 

7. Double-click the new topic. 

8. Right-click in a white space and choose new to create a new word. 

9. Double-click the NEW WORD.  

10. Type in a short name such as Attachment (If setting up a lab folder, it might be called 

Lab Information:). 

11. Select the Question, List, and Entry Break checkboxes located in the upper right hand 

corner of the screen. 

12. Click OK. 

13. Create a second new word right under the Attachment word. Follow steps 8 and 9 to 

create the word.  

14. Type in a short name such as “get attachment” (If setting up a lab folder, it might be 

called “get lab attachment). 

15. Select the Picture checkbox. 

16. Click OK to save. 

 


